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Abstract 

This document provides information about the updates made to the Microsoft® Application 

Compatibility Toolkit (ACT) 5.6, including the upgrade path to use when updating your product 

and the known issues, including any potential workarounds or solutions. 

 
 



 

 

Copyright Information 

This document is provided “as-is”. Information and views expressed in this document, including 

URL and other Internet Web site references, may change without notice. You bear the risk of 

using it. 

Some examples depicted herein are provided for illustration only and are fictitious. No real 

association or connection is intended or should be inferred. 

This document does not provide you with any legal rights to any intellectual property in any 

Microsoft product. You may copy and use this document for your internal, reference purposes. 

© 2010 Microsoft Corporation. All rights reserved. 

 

Active Directory, Internet Explorer, Microsoft, Windows, Windows NT, Windows XP, 

Windows Vista, Windows 7, and Windows Server are trademarks of the Microsoft group of 

companies. 

 

All other trademarks are property of their respective owners. 

 



 

 

Contents 

Microsoft ACT 5.6: Release Notes .................................................................................................. 4 

Updates to the Microsoft Application Compatibility Toolkit .......................................................... 4 

Updated Deprecation Issue Detection ...................................................................................... 4 

Support for 64-bit Operating Systems and Applications ........................................................... 4 

Compatibility Evaluator Support ............................................................................................ 4 

Application Compatibility Manager Support .......................................................................... 4 

Standard User Analyzer Support ........................................................................................... 4 

Compatibility Administrator Support ...................................................................................... 5 

Microsoft Compatibility Exchange Support ........................................................................... 5 

Improved Community Assessments ......................................................................................... 5 

Improved ACT Compatibility Web Service Performance .......................................................... 5 

Inclusion of the StockViewer Demonstration Application ......................................................... 5 

Help to Improve ACT ................................................................................................................ 5 

Upgrading the Application Compatibility Toolkit ........................................................................... 5 

Upgrade by Using the Application Compatibility Manager ....................................................... 6 

Download and Reinstall the Latest Version of ACT .................................................................. 6 

Known Issues ............................................................................................................................... 6 

Potential Restart During the Upgrade Process ......................................................................... 6 

Issue with SQL Server Database Role Assignment ................................................................. 7 

ACT Log Processing Service and Network Failures ................................................................. 7 

Microsoft Compatibility Exchange and Proxy Server Synchronization Issues ......................... 7 

.NET Framework 2.0 Issues with Windows Vista ..................................................................... 7 

Application Compatibility Manager Crashes When Modifying a Moved Data Collection 

Package ................................................................................................................................. 8 

Internet Explorer Compatibility Test Tool (IECTT) Fails to Open ............................................. 8 

Missing Object Names in the IECTT ......................................................................................... 8 

Potential Restart During the Uninstallation of the Data Collection Package (DCP) ................. 8 

ACT Data Collection Packages May Not Uninstall on Windows 2000 Computers .................. 9 

Uninstalling DCPs ..................................................................................................................... 9 

Compatibility Reports Contain Data Merged from Multiple Computers .................................... 9 

Modifying the Output Log File Location .................................................................................... 9 

Update Compatibility Evaluator (UCE) and Filtered Applications ............................................. 9 

Running Data Collection Packages Created by Using Windows Vista or Windows 7 on a 

Windows 2000 Computer .................................................................................................... 11 



 

 
4 

Microsoft ACT 5.6: Release Notes 

This document provides information about the Microsoft® Application Compatibility Toolkit 

(ACT) 5.6 release, including the updates made to the product for this release, how to update your 

product, and various known issues and any potential workarounds or solutions. If you find issues 

in the product that are not listed within this document, contact Microsoft by using the Send 

Feedback link in the Help menu. 

Updates to the Microsoft Application 
Compatibility Toolkit 
The ACT 5.6 helps customers understand their application-compatibility situations by identifying 

applications that are compatible with the Windows® 7 operating system and applications that 

require further testing. ACT helps customers lower their costs for application-compatibility testing, 

prioritize their applications, and deploy Windows 7 more quickly. 

Updated Deprecation Issue Detection 

The Windows Compatibility Evaluator (WCE) now detects files that were deprecated in 

Windows Vista® and Windows 7. This includes detection for the use of winmail.exe, milcore.dll, 

outlook.exe, and msagent.exe. 

Support for 64-bit Operating Systems and Applications 

ACT 5.6 now supports both running on and providing issue detection for 64-bit operating systems 

and applications. 

Compatibility Evaluator Support 

The ACT compatibility evaluators can now operate on computers that are running a 32-bit version 

or a 64-bit version of Windows. In addition, the compatibility evaluators can now detect issues for 

both 32-bit and 64-bit applications. 

Application Compatibility Manager Support 

ACT 5.6 enables you to test and separately evaluate both 32-bit and 64-bit applications that are 

running on Windows 7. 

Standard User Analyzer Support 

The Standard User Analyzer (SUA) tool enables you to use a computer that has a 32-bit or a 64-

bit version of Windows to fix compatibility issues that occur with 32-bit applications. 



 

 
5 

Compatibility Administrator Support 

ACT 5.6 automatically installs a 64-bit version of the Compatibility Administrator on a computer 

that is running a 64-bit version of the Windows operating system. You can use this version of the 

Compatibility Administrator to create and apply compatibility fixes (previously known as “shims”) 

to 64-bit and Microsoft Intermediate Language applications. 

Microsoft Compatibility Exchange Support 

The Microsoft Compatibility Exchange Web service can now provide vendor assessments for 

both 32-bit and 64-bit applications and update impact reports for 64-bit operating systems. 

Improved Community Assessments 

ACT 5.6 has updated the ACT Community to use a voting mechanism that displays application 

compatibility ratings in the Community Assessment column of the Analyze screen. This new 

mechanism combines your application assessment information with all of the information 

provided by the other ACT Community members. 

Improved ACT Compatibility Web Service Performance 

ACT 5.6 uses an improved Microsoft Compatibility Exchange Web service that decreases the 

amount of time required to synchronize your compatibility data with Microsoft and increases the 

reliability of the synchronization process. 

Inclusion of the StockViewer Demonstration Application 

You can use the StockViewer demonstration application with the Mitigating Issues by Using 

Compatibility Fixes topic in the ACT online Help to learn how to locate and fix compatibility issues 

by using both the SUA and the Compatibility Administrator tools. 

Help to Improve ACT 

ACT now sends your usage data back to Microsoft. This data enables Microsoft to identify the 

shifting trends in operating system and hardware usage and to tailor future versions of ACT to 

best suit your application-compatibility needs. The information that is collected by ACT is not 

personally identifiable. For more information about this program, including how to opt out, see 

Using the Preferences Tab in the ACT online Help system. 

Upgrading the Application Compatibility Toolkit 
You can upgrade to ACT 5.6 by using either of the methods listed in this section. 

http://go.microsoft.com/fwlink/?LinkId=192187
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Upgrade by Using the Application Compatibility Manager 

If you have configured the Application Compatibility Manager to check for new versions of ACT, 

you can upgrade ACT by using the prompt provided by the Application Compatibility Manager. 

You may be required to restart your computer if you are running Windows Vista or 

Windows Vista® with Service Pack 1 (SP1). 

1. Open the Application Compatibility Manager. 

2. On the Tools menu, click Settings. 

The Settings dialog box appears. 

3. Click the Preferences tab. 

4. Verify that you have selected the Notify me when a newer version of ACT is available 

(recommended) check box. 

Note  

If the check box is not selected, you can do it now, and the Application 

Compatibility Manager will search for any updates the next time you start the 

program. 

Download and Reinstall the Latest Version of ACT 

You can uninstall your existing version of ACT and then download and install the latest version 

from the Microsoft Application Compatibility Toolkit 5.6 Web page. Uninstalling the toolkit does 

not remove or delete your database or your log files, and the installation acts much like an 

upgrade. However, you must complete the ACT Configuration Wizard again when you open the 

Application Compatibility Manager. 

Known Issues 
The following section provides detailed information about the known issues, including any known 

workarounds or solutions. 

Potential Restart During the Upgrade Process 

You may be required to restart your computer if you are running Windows Vista or 

Windows Vista® with Service Pack 1 (SP1) and you upgrade your version of ACT by using the 

prompt provided by the Application Compatibility Manager 

Important  

To verify if the Application Compatibility Manager is configured to check for the 
updates 

http://go.microsoft.com/fwlink/?LinkId=184583
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Issue with SQL Server Database Role Assignment 

If your organization does not allow the assignment of the db_owner database role to a user, then 

you must instead grant the following reduced permissions to that specific user for every stored 

procedure. Without these permissions, the Application Compatibility Toolkit fails to start or to 

function for that user. 

 SELECT 

 INSERT 

 UPDATE 

 DELETE 

 EXECUTE 

ACT Log Processing Service and Network Failures 

If your network experiences a failure or a disconnection for a significant period of time (typically, 

more than 30 seconds), the ACT Log Processing Service can enter a state where it no longer 

processes your log files. To fix this issue, you must restart the ACT Log Processing Service. 

1. In Control Panel, click Administrative Tools, and then click Services. 

The Services dialog box appears. 

2. Click the ACT Log Processing Service, and then click Restart. 

Microsoft Compatibility Exchange and Proxy Server 
Synchronization Issues 

You can experience synchronization failures between the Microsoft Compatibility Exchange and 

proxy servers in your organization if you select certain proxy server options. The Windows 

operating system supports three proxy server configuration options, which you can use in any 

combination. However, if all of the following are true, the Application Compatibility Manager fails 

to synchronize: 

 You have selected the Manually Specify Proxy Server option. 

 You have enabled one or both of the other available Proxy Location options. 

 The user specifies a proxy server that requires authentication. 

To fix this issue, disable all other options except for Manually Specify Proxy Server and then try 

to synchronize again. 

.NET Framework 2.0 Issues with Windows Vista 

When you try to synchronize your compatibility data, you can experience an issue where you are 

prompted to provide your domain account information to access the proxy computer. However, 

domain credentials are not recognized by the proxy computer and your security check fails. 

To restart the ACT Log Processing Service 
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To fix this issue, refer to the following article: FIX: The System.Net.HttpWebRequest class may 

not maintain a persistent connection to a proxy in the .NET Framework 2.0. 

This issue appears only if you are using NTLM authentication on a computer that is 

running Windows Vista. 

Application Compatibility Manager Crashes When Modifying a 
Moved Data Collection Package 

The Application Compatibility Manager can crash if you attempt to modify and save an existing 

data collection package (DCP) that no longer exists in its original location. To avoid this issue, 

save the modified DCP to the database by clicking Save to Database on the File menu. 

Internet Explorer Compatibility Test Tool (IECTT) Fails to Open 

Opening the Internet Explorer Compatibility Test Tool (IECTT) on a computer that is running 

Windows Vista with SP1 can generate the following error message:  Test Tool Error. The file 

size exceeds the limit allowed and cannot be saved. For more information about this issue and 

how to fix it, see KB954368: Error message when you open the Internet Explorer Compatibility 

Test Tool on a Windows Vista Service Pack 1-based computer: "The file size exceeds the limit 

allowed and cannot be saved". 

Missing Object Names in the IECTT 

You can find that two event types, Codepage Sniffing and Certificate Filtering, do not return 

object names to the IECTT. Because there are no object names associated with these events, 

they appear blank in the Object Name field of the IECTT, and they also appear with the title 

blank in the Web Site field of the Application Compatibility Manager Web Site Report screen. 

In addition, if you double-click to view the associated issue details, the blank dialog box appears 

with the included details. 

At this time, there is no workaround to return the object names; however, all of the important 

details are still returned to the IECTT and the Application Compatibility Manager. 

Potential Restart During the Uninstallation of the Data Collection 
Package (DCP) 

If a user is using the Event Viewer to view events being generated by the ACT data collection 

package (DCP) at the same time that the package is being automatically uninstalled, it may 

cause the system to require a restart to restore certain system services after uninstallation is 

complete. This is a known issue only for computers running Windows 7 or Windows 

Server® 2008 R2. 

Important  

http://go.microsoft.com/fwlink/?LinkId=103489
http://go.microsoft.com/fwlink/?LinkId=103489
http://go.microsoft.com/fwlink/?LinkId=125859
http://go.microsoft.com/fwlink/?LinkId=125859
http://go.microsoft.com/fwlink/?LinkId=125859
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ACT Data Collection Packages May Not Uninstall on 
Windows 2000 Computers 

Computers that are running Windows 2000 without Service Pack 4 (SP4) and Update Rollup 1 

might have difficulties automatically uninstalling a DCP at the end of its scheduled duration. To 

work around this issue, manually uninstall the DCP (see “Uninstalling DCPs” in this section) or 

use only computers that are running Windows 2000 with Service Pack 4 (SP4) and Update 

Rollup 1. 

Uninstalling DCPs 

ACT 5.6 creates Windows Installer (.msi) packages for your DCPs. To uninstall a DCP, use one 

of the following methods: 

 Command-line. You can use the following syntax to uninstall a DCP: 

afsetup.exe /uninstall 

 Add or Remove Programs. To uninstall Microsoft Application Compatibility Data 

Collector 5.6 you can use the Add or Remove Programs item in Control Panel. 

Compatibility Reports Contain Data Merged from Multiple 
Computers 

You might find that some of your compatibility reports contain data merged from multiple 

computers. This occurs due to the way the ACT uniquely identifies the individual client computers 

by using the media access control (MAC) address from the client computer network adapter. If a 

client computer is inventoried while connected through a virtual protocol network (VPN), the same 

MAC address can appear for multiple computers, causing the data to be merged in the 

compatibility reports. 

Modifying the Output Log File Location 

If you need to dynamically change where your DCP log files are being stored, you can use the 

INSTALLDIR command-line option and the following syntax: 

Msiexec /i <dcp_package_name.msi> INSTALLDIR=<new_directory_location> 

Because the DCP runs as a service by using the local system credentials, you must 

verify that the new log-file location has the appropriate permissions. For more information 

about the correct permissions, see the “Share Level Permissions” section of 

Troubleshooting ACT Setup, located in the ACT online Help system. 

Update Compatibility Evaluator (UCE) and Filtered Applications 

To reduce the impact on client computers and the ACT Log Processing Service, the Update 

Compatibility Evaluator (UCE) does not record the dependencies for certain .exe files that depend 

Important  

http://go.microsoft.com/fwlink/?LinkId=192226
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on excessive amounts of files or registry entries. However, you can instruct the UCE to record 

these application dependencies by choosing the Include filtered applications option in the 

Compatibility Evaluator Settings dialog box. For information, see Configuring Advanced 

Settings, located in the ACT online Help system. 

Including the filtered applications increases the total amount of data written to your client 

computer hard drive, which can increase the impact of UIAConvert.exe on your client 

computer and can result in more data being uploaded to your ACT Log Processing share. 

By default, the UCE does not record dependencies for the files and the applications listed in the 

following tables: 
 

Operating System Files 

explorer.exe lsass.exe 

svchost.exe services.exe 

wmiprvse.exe   

 

 

Application Compatibility Toolkit Components 

actdcsvc.exe collect.exe 

UIAConvert.exe UIAService.exe 

 

 

Antivirus, Anti-spyware, and Desktop Search Applications 

Ad-Aware.exe awsepersonal.exe 

csscan.exe eTrust.exe 

filts800a_s.exe GoogleDesktop.exe 

GoogleDesktopCrawl.exe GoogleDesktopDisplay.exe 

GoogleDesktopIndex.exe GoogleDesktopManager.exe 

InocIT.exe InoRpc.exe 

InoRT.exe Mcshield.exe 

navw32.exe navwnt.exe 

PcCVScan.exe PcScnSrv.exe 

SafeSweeper.exe scan32.exe 

SpySweeper.exe swdoctor.exe 

Note  

http://go.microsoft.com/fwlink/?LinkId=192225
http://go.microsoft.com/fwlink/?LinkId=192225


 

 
11 

Antivirus, Anti-spyware, and Desktop Search Applications 

textExtractor.exe unregaaw.exe 

wds_sl.exe windowssearch.exe 

windowssearchfilter.exe windowssearchindexer.exe 

windowssearchsafefilter.exe YDSsystray.exe 

 

Running Data Collection Packages Created by Using 
Windows Vista or Windows 7 on a Windows 2000 Computer 

If you created a data collection package (DCP) by using the Application Compatibility Manager on 

a computer running Windows Vista, and you are running that DCP on a computer running 

Windows 2000, you might receive an error that states This is not a valid Win32 application. 

To work around this issue, you must create the DCP on a computer running either Windows XP 

Service Pack 2 or Windows Server 2003. 
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